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Intended Use of the Vector Control Development Kit 
The Vector Control Development Kit is designed for demonstration and 
development purposes only and must not be included in other electrical 
installations!

General 
During operation, the Vector Control Development Kit has exposed hot 
surfaces, uninsulated contacts, and rotating parts when the motor is con-
nected. If used or installed improperly, there is a danger of a serious per-
sonal injury and/or damage of property. All installation and use must be 
performed by skilled technical personnel!

Safeguards
The following precautions must be observed when working with the 
devices described in this document.

Always use a grounding strap to prevent damage resulting from 
electrostatic discharge (ESD).

Revision History
The following table provides a revision history of this document.

Date
Revision
Level Description of Change

Page(s)
Affected

February 2007 1 Original Issue All
April 2007 2 Added warnings. ii, 1, 5, 
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Introduction
The Vector Control Development Kit should only be used by 
technicians and engineers who are experienced in power elec-
tronics!

The Vector Control Development Kit is designed to help you develop 
motor control applications using the ZiLOG Z8FMC16100 Motor Control 
MCU. A 350-VDC, 15,000-RPM, 500-W, three-phase AC-induction 
motor is included with the kit if you ordered ZVECTOR0100ZCO.

Caution:
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Vector Control Development Kit
Kit Contents

The following items are included in the Vector Control Development Kit:

• Vector Control Unit (Control Unit)

• Optoisolated USB Smart Cable (Smart Cable)

• Six-circuit ribbon cable

• USB cable, type A to B

• USB-to-UART cable

• Vector Control CD-ROM containing demonstration code (Demo 
project, which is also programmed in the Control Unit) and Vector 
Control Panel host application

• ZDS II—Z8 Encore! 4.10.0 Development Software CD-ROM

• User manual

• Z8FMC16100 Series Motor Control MCU Easy Reference Chart

• Three-phase AC-induction motor (350 VDC, 500 W, and 15,000 
RPM) is included if you ordered ZVECTOR0100ZCO

• Twenty-four-inch motor cable with six wires of 16 AWG and insu-
lated female spade connectors (Figure 1 on page 3)
UM021402-0407 Vector Control Development Kit
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Figure 1. Motor Cable

System/Software Requirements
An IBM PC (or compatible computer) is required with the following rec-
ommended configurations:

• Windows XP Professional

• Pentium III/500-MHz processor or higher

• 128-MB RAM or more
UM021402-0407 Vector Control Development Kit
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• 135-MB hard disk space or more (includes application and documen-
tation) or 35-MB hard disk space (application only)

• Super VGA video adapter

• CD-ROM for installation

• Two available USB high-speed ports

• Internet browser (Internet Explorer or Netscape)

Hardware/Materials Requirements
• One adjustable power supply, 1–48 VDC, 3A

• Clip-on leads to connect the Control Unit to the DC power supply
UM021402-0407 Vector Control Development Kit
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Setting up the Kit
To avoid damage to the development kit, ZiLOG recommends 
that you use a bench DC power supply instead of AC power un-
til your software is stable. Do not connect both the AC power 
cord and the DC power supply at the same time.

Before applying power, make sure that there are no loose wires or metal 
parts inside the unit. When the unit is connected to voltages above 
30 VAC/60 VDC, all of the components inside the enclosed unit must be 
considered “hot,” and any contact with the board must be avoided. The 
user must stay away from the unit because of the risk of projectiles of 
materials in case of components destruction, especially when applying 
high voltages.

Use the instructions below to set up the kit before running the demonstra-
tion code in standalone mode:

1. Insert the CD with the Demo project into a CD-ROM drive and fol-
low the instructions to install the Demo project and the Vector Con-
trol Panel host application.

2. Connect the USB-to-UART cable (Figure 2 on page 6) between a PC 
and connector M-P3 of the Control Unit.

The UART side connector is polarized. Make sure to properly 
plug in the connector.

3. Follow the setup procedure in “Setting up the COM Port and Speed” 
on page 6 for the USB-to-UART cable (Figure 2 on page 6) to set up 
communication between a PC and the Control Unit.

Caution:

Note:
UM021402-0407 Setting up the Kit
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Figure 2. USB-to UART Cable

Setting up the COM Port and Speed
To set up the COM port and speed, use the following procedure:

1. From the Start menu on the Windows desktop, select the Control 
Panel.

2. Double-click the System icon.

The System Properties dialog box is displayed.

3. In the Hardware tab, click Device Manager.

The Device Manager window is displayed.

4. Under Ports (COM & LPT), check which COM port was mapped to 
the USB-to-UART cable.

Orange and yellow

wires are press fit

together into the

middle connector.
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5. Select Exit from the File menu to close the Device Manager window.

6. Click OK to close the System Properties dialog box.

7. If the Control Panel application is not running, start the Control Panel 
(Start > Programs > ZiLOG Vector Control > Control Panel).

See Figure 3.

Figure 3. Control Panel
UM021402-0407 Setting up the Kit
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8. In the Control Panel, select the same COM port that Windows 
mapped the USB-to-UART cable to (see Step 3).

9. Connect the motor to the Control Unit using the motor cable as shown 
in Figure 4 on page 8, Figure 5 on page 9, and Figure 6 on page 10.

Figure 4. Control Unit and Motor Connection Diagram
UM021402-0407 Setting up the Kit
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Figure 5. Control Unit Connection

Frame
Ground/Motor
Case

FGND

3 Motor Leads
PH-A
PH-B
PH-C

Tachogenerator
Inputs

T2
T1
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Figure 6. Motor Connection

10. Set the adjustable power supply to 0 VDC and connect it to the Con-
trol Unit using clip-on leads as following
a. Connect the negative (-) lead of your adjustable power supply to 

spade lug connector AC-2 on the Vector Control Unit.
b. Connect the positive (+) lead of your adjustable power supply to 

spade lug connector AC-1 on the Vector Motor Control Unit.

11. Gradually increase the voltage on the DC Power Supply to ~48VDC.

12. In the Control Panel (Figure 3 on page 7), click Update Target.

Frame
Ground/Motor
Case

FGND

3 Motor Leads
PH-A
PH-B
PH-C

Tachogenerator
outputs

T2
T1
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13. In the Control Panel, select the Run button in the Mode area and 
observe as the motor starts spinning. 

If the motor does not start, click Update Target and select the Run 
button in the Mode area again.

Bringing up the DC supply to 48 V is enough to power up the HV 
power module. It is a good practice to program the FMC16100 MCU 
with the input voltage at 48 V. Vector Control is a current regulator, so 
it can be run at this low voltage.

14. Now you can start changing speed, proportional gain, and integral 
gain on the Vector Control Panel and observe how the motor reacts to 
the changes.

15. After seeing how the demonstration operates, turn the adjustable 
power supply to 0 VDC and unplug the power supply from the board.

Note:
UM021402-0407 Setting up the Kit
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Downloading and Running the 
Sample Demonstration Code

Downloading and running the demonstration code involves some or all of 
the following general steps:

1. Install ZDS II—Z8 Encore! 4.10.0 development software, the USB 
device drivers, and the demonstration code.

2. Configure and connect the target hardware.

3. Use ZDS II to build, download, and run/debug the demonstration 
code and project.

The sections below provide the details needed to complete these steps.

Install the ZDS  II—Z8 Encore! 4.10.0 Development Soft-
ware

Perform the following steps to install the software tools:
a. Insert the provided ZDS II CD into your computer’s CD-ROM 

drive.
If the installation program does not start automatically, execute 
the launch.exe file from the root of the CD-ROM.

b. Select “Install ZiLOG Developer Studio” to install. 
Other software and accompanying documentation can be 
installed later.

c. Follow the instructions on the screen to complete the installation.
UM021402-0407 Downloading and Running the Sample 
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Install the USB Smart Cable Driver Software and USB 
Smart Cable

The USB Smart Cable connects the development kit to a high-speed or 
full-speed USB port on your ZDS II host system. Its internal optoisolator 
electrically isolates the development kit circuitry from the USB Smart 
Cable. 

The USB Smart Cable is enclosed in a black box that connects to the host 
PC using a USB cable (included in kit). The USB Smart Cable housing 
connects to the development kit using a six-circuit ribbon cable.

The steps to install the USB Smart Cable are included with ZDS II. The 
file can be found at one of the following locations:

• <ZiLOG Developer Studio II Installation Directory>\ 
device drivers\USB

• <ZiLOG Developer Studio II Installation CD>\ 
Device Drivers\USB

Follow the instructions for the appropriate operating system. 

Do not connect power to the application board before connecting a 
USB Smart Cable to both the host PC and development board.

Configure and Connect the Target Hardware
1. Stop the preloaded demonstration code, set the power supply to 

0 VDC, and disconnect the power supply from the Control Unit.

2. Using the six-pin ribbon cable (Figure 7 on page 14), connect the 
Smart Cable to the connector that is available on the Control Unit 
through the opening in the clear cover. Make sure that the red strip on 
the ribbon cable (pin1) is oriented toward the power connector of the 
Control Unit.

Note:
UM021402-0407 Downloading and Running the Sample 
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Figure 7. Six-Pin Ribbon Cable

3. Connect and apply power to the development kit as described in “Set-
ting up the Kit” starting on page 5.

This sets the voltage to 48 VDC.

Do not apply power to the application board unless the USB 
Smart Cable is connected both to the host PC and to the devel-
opment board’s DBG port.

Build, Download, and Run the Demonstration Code
Perform the following procedure to open the DemoApp.zdsproj sample 
project and run the code:

1. Run the ZDS II software using the Start menu shortcut. By default, 
ZDS II can be found at Start → Programs → ZiLOG ZDS  II -  
Z8Encore! 4.10.0.

2. Select Open Project from the File menu and browse to the Vector 
Control demonstration code, which is located by default at
C:\Program Files\ZiLOG\VectorControl_1.0\DemoApp

3. Select the DemoApp.zdsproj file and click Open to load the 
project. 

4. Ensure that the USB Smart Cable is the selected debug tool.
a. Select Settings from the Project menu to display the Project Set-

tings dialog box. 

Note:

Caution:
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b. In the Project Settings dialog box, select the Debugger tab and 
make certain that the target selected in the Target area is 
DemoApp.

c. Select the Debugger tab and ensure that USBSmartCable is the 
selected debug tool. 

d. Click Setup under the debug tool selection field and ensure that a 
valid serial number is selected. 

e. To save changes, click OK to close all dialog boxes.

5. In the upper left corner of the Project Settings dialog box, make cer-
tain that the Debug build mode is selected.

6. Build the demonstration project by selecting Rebuild All from the 
Build menu.The build output is displayed in the Output window at the 
bottom of the ZDS II window.

7. Select Reset from the Debug menu to initiate a debug session and to 
connect and download the code to the development board.

8. When the Option Bits Warning dialog box shown in Figure 8 dis-
plays, click Yes to continue.

Figure 8. Option Bits Warning Dialog Box

9. Select Go from the Debug menu to start the program.

10. In the Control Panel (Figure 3 on page 7), click Update Target.
UM021402-0407 Downloading and Running the Sample 
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11. In the Control Panel, select the Run button in the Mode area and 
observe as the motor starts spinning. 

If the motor does not start, click Update Target and select the Run 
button in the Mode area again.

Bringing up the DC supply to 48 V is enough to power up the HV 
power module. It is a good practice to program the FMC16100 MCU 
with the input voltage at 48 V. Vector Control is a current regulator, so 
it can be run at this low voltage.

12. Now you can start changing speed, proportional gain, and integral 
gain on the Vector Control Panel and observe how the motor reacts to 
the changes.

For more information about using ZDS II and building projects for your 
Z8FMC16100 Series Motor Control Development Kit, refer to the ZiLOG 
Developer Studio II—Z8 Encore!® User Manual (UM0130).

Troubleshooting Tips
If you experience trouble running the demo program with the Vector Con-
trol Development Kit, check the following before contacting ZiLOG 
Technical Support for assistance:

• Verify that you are using the correct version of the development tools: 
ZDS II—Z8 Encore! version 4.10.0. 

• Make sure you are using the unmodified sample project code as 
described in “Downloading and Running the Sample Demonstration 
Code” on page 12. 

• Verify that you have properly connected the USB Optoisolator Smart 
Cable to the host PC as described in “Install the USB Smart Cable 
Driver Software and USB Smart Cable” on page 13. Ensure that pin 1 

Note:
UM021402-0407 Downloading and Running the Sample 
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of the cable is properly aligned with DBG connector pin 1 (C_P18) of 
the development kit (see Figure 11 on page 24).

• In ZDS II (Project > Settings... > Debugger tab), verify that 
DemoApp is selected as the target and that USBSmartCable is the 
selected debug tool. Verify that the serial number for the USB 
Optoisolator Smart Cable interface is selected and configured using 
the Setup button under the Debug Tool selection field.

• Ensure that the project builds with no errors. To do so, select Rebuild 
All from the Build menu and view the build results in the Output win-
dow’s Build tab.

• Verify that the development board is not currently running any 
code—the motor should not be spinning.

• Try reloading the sample project as described in “Downloading and 
Running the Sample Demonstration Code” on page 12.

If you perform these steps and cannot get the demonstration code to run, 
contact ZiLOG Technical Support at www.ZiLOG.com.

Theory of Operation
In this application, the FMC16100 microcontroller’s PWM module is 
configured as three complementary output pairs. Each output pair con-
trols one complementary source/drain transistor pair in the inverter 
bridge. The PWM module is configured to insert a 0.6 µS dead band 
between ON states to prevent leakage that might occur if one transistor in 
a pair turns on before the other is fully off.

Each PWM output pair produces a stream of complementary on/off pulses 
to activate the corresponding source or drain transistor in the inverter 
bridge. The voltage of each bridge output varies with the source/drain 
pulse duty cycle. 
UM021402-0407 Downloading and Running the Sample 
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The period of each PWM cycle is configured to be 50 µS, and the PWM 
module generates an interrupt request at the end of each cycle. The PWM 
interrupt service routine (ISR) leaves the PWM interrupt disabled while it 
executes, and is tuned to execute within 200–250 µS. Therefore, the 
PWM ISR is executed every five PWM cycles, or 250 µS.

The PWM ISR controls all of the ongoing application program functions 
after initialization. The primary goal of the ISR is to update the duty cycle 
value for each PWM channel as needed to produce the desired AC wave-
forms at the inverter bridge outputs.

The PWM duty cycle values are derived from a feedback loop based on 
rotor speed and rotor flux position. The stator current waveform is deter-
mined by sampling two phases of the inverter output current and recon-
structing the third phase. 

The rotor speed is sampled by a counter/timer configured to measure the 
period of a magnetic position sensor on the motor. The measured speed is 
periodically compared to the requested speed received via UART from an 
external controller. The resulting speed command value is used to create a 
rotation reference frame expressed as a two-phase direct/quadrature (DQ) 
vector. The resulting vector is regulated to produce the necessary flux and 
torque amplitude in the output vector. 

An inverse Park transform is used to rotate the reference frame relative to 
the rotor position. Then an inverse Clarke transform is used to convert the 
rotated two-phase reference frame back into a three-phase expression. At 
the same time, the vector’s position is classified into one of six states, 
each corresponding to one sixth of the vector circle.

When the ISR calculates duty cycles for the three PWM channels, one 
phase is left unmodulated (ON or OFF for the whole PWM cycle), and the 
flux vector is encoded by modulating the other two phases. This reduces 
switching losses by one third. The two phases to be modulated depend on 
the flux vector’s state position. After the PWM space vector calculation is 
complete, the corresponding PWM registers are updated.
UM021402-0407 Downloading and Running the Sample 
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For an example of a vector-control application, see the Vector Control of a 
3-Phase AC Induction Motor Using the FMC16100 MCU Application 
Note (AN0247).
UM021402-0407 Downloading and Running the Sample 
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Block Diagram
A block diagram of the Vector Control Development Kit is shown in 
Figure 9.

Figure 9. Vector Control Development Kit Hardware Block Diagram
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Description of the Hardware
The hardware interface of the Vector Control Unit consists of the follow-
ing:

• Insulated gate bipolar transistors (IGBTs)

Six 6SGS5N60RUFD insulated-gate bipolar transistors are used 
under PWM control to generate the required 3-phase AC motor drive 
current from a high-voltage DC supply. Although these IGBTs are 
rated for momentary short-circuit operation, the Z8 Encore! MC™ 
PWM deadband feature is used to reduce leakage when the IGBTs are 
switched.

Three IR21064S high- and low-side gate drivers are used to convert 
the Z8 Encore! MC™ microcontroller’s CMOS PWM outputs into 
signals with the voltage needed to drive the IGBT gate inputs.

• High-voltage (HV) gate drive module

This module contains the three IR21064S high- and low-side gate 
drivers that convert the Z8 Encore! MC™ microcontroller PWM out-
puts into the voltage needed to drive the IGBT gate inputs.

The module uses 600-V level-shifted drivers for the three high-side 
IGBTs.

• UART interface module

This module interfaces to the tachogenerator and optoisolated UART. 
The tachogenerator produces a single sine wave with voltage and fre-
quency proportional to motor speed. The optoisolators are used for 
UART communication.
UM021402-0407 Description of the Hardware
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• FMC16100 control module

This module contains the Z8 Encore! MC™ microcontroller, a  
20-MHz ceramic resonator, the ZiLOG 6-pin DBG interface, and the 
off-chip components of the high-voltage current sense and overcur-
rent detection circuits.

• High-voltage power module

This module uses an LNK304G IC to convert rectified AC from the 
power stage to generate the application’s 120-mA, 12-V supply. This 
12-V supply is then regulated by a UA78M33 IC to provide the 3.3V 
supply.

The HV power module contains an unisolated switcher. A Buck con-
verter takes the 240-VDC (rectified AC) bus and generates 15 V for 
the gate drivers. A 3.3-V regulator converts 15 V to 3.3. V for the 
MCU, DAC, and any auxiliary circuitry.

• Digital-to-analog converter (DAC) module

The Z8 Encore! MC™ microcontroller’s I2C interface is used with a 
DAC5574 digital-to-analog-converter to generate up to four analog 
test outputs based on internal program values. This allows the internal 
values to be directly compared to the motor controller’s output wave-
form on an oscilloscope. 

The I2C data is sent from the FMC16100 control module. The outputs 
are 8-bit data scaled to the 3.3-V supply. The real-time data is updated 
every 250 µs on the A channel.

• Rectifier

A full-bridge rectifier passes the DC to the bus.

• Relay

The relay is a disconnect for the DC bus voltage.
UM021402-0407 Description of the Hardware
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• Bus capacitors

The bus capacitors provide storage for the DC bus voltage.

Figure 10 shows the Vector Control Unit.

Figure 10. Vector Control Unit
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Figure 11 shows the Vector Control Unit connection.

Figure 11. Vector Control Unit Connection

To motor
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Power in
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Hardware Specifications and Power Requirements

Input
100–120 VAC at 60 Hz (voltage doubler connection), 200–240 VAC at 
50/60 Hz, 50–350 VDC

United States
In the United States, use 110 VAC (voltage doubler). See Figure 12.

• AC-2 Line

• C-T Neutral

Figure 12. Power Connections (United States)
UM021402-0407 Description of the Hardware
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Outside of the United States
Outside of the United States, use 220-240 VAC. See Figure 13.

• AC-1 Line

• AC-2 Neutral

Figure 13. Power Connections (Outside of the United States)
UM021402-0407 Description of the Hardware
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Example of a Motor Control Rou-
tine

The overall program flow is illustrated in Figure 14 on page 28. After 
main() initializes the application, it drops into an infinite loop. Mean-
while, the PWM timer generates an event every 50 µs. The PWM ISR is 
timed to execute on every fifth PWM event, once every 250 µs. The ISR 
calls one of ten low-priority subfunctions on every loop cycle, so each 
subfunction is called once every 2.5 ms. Figure 15 on page 29 illustrates 
the PWM ISR main loop.
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Figure 14. Flowchart for the Application

Initialization

Infinite Loop

Calculate/Update
PWM Values

Refresh 
WDT Timer

Tach Update 1

Tach Update 2

Tach Update 3

Field Weakening

Slip Update

Speed Regulator

UART

Unused

Unused

Communication

Unused

Wait for Fifth
PWM Period

(250 µs Loop)

PWM Interrupt

Return

main()

PWM Timer
Events (50 µs)

Service Routine

0–9 Step
Round-Robin
UM021402-0407 Example of a Motor Control Routine



Vector Control Development Kit
User Manual

29
Figure 15. Flowchart for the PWM ISR
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Timing Descriptions
For details about timing, see the Vector Control of a 3-Phase AC Induc-
tion Motor Using the FMC16100 MCU Application Note (AN0247).
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Appendix A—AC Power Cable 
Assembly

The power cable is not included in the kit and must be assembled by the 
user.

For the power cable, use a local power plug with in-line Fast Blow fuse of 
10 AMP for 120 VAC or 5 AMP for 240 VAC. For the connection to the 
Control Unit, use insulated 0.25-inch female spade connectors. See 
Figure 16.

 

Figure 16. Power Cable
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Appendix B—Control Panel

Figure 17. Control Panel
UM021402-0407 Appendix B—Control Panel
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The following options are available in the Control Panel:

• Stop button

The Stop button stops the motor.

• Coast button

The Coast button allows the motor to continue running without addi-
tional power.

• Run button

The Run button starts the motor.

• Speed Command drop-down list box

The Speed Command drop-down list box allows you to set the speed 
of the motor. The default is 50. 

• Proportional Gain drop-down list box

The Proportional Gain drop-down list box allows you to set the pro-
portional gain of the motor. The default is 200. 

• Integral Gain drop-down list box

The Integral Gain drop-down list box allows you to set the integral 
gain of the motor. The default is 75. 

• Update Target button

The Update Target button sends the instructions from the Control 
Panel to the motor.

• Save Data button

The Save Data button saves the raw speed data that is displayed on 
the screen in the data.csv file located in the same directory as the 
Vector Control executable. The default location is
C:\Program Files\ZiLOG\VectorControl_1.0\ 
Control Panel
UM021402-0407 Appendix B—Control Panel
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• COM Port drop-down list box

The COM Port drop-down list box allows use to select the port that 
the USB-to-UART cable is mapped to in Windows.

• Time Scale drop-down list box

The Time Scale drop-down list box changes the number of seconds 
per division of the motor speed graph. The default is 0.1 seconds per 
division.
UM021402-0407 Appendix B—Control Panel
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ppendix C—Schematics
Figure 18 through Figure 23 are the schematic diagrams for the Vector Control application modules.

Figure 18. High-Voltage Main Board Schematic
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Figure 19. FMC16 Control Module Schematic

1 2 3 4 5

54321

D

C

B

A

Title

NuSize

B

Date: 19-J
File: C:\D

C_CS-

C
_T

E
M

P

C_XOUT

C_AL

C
_N

R
E

S
E

T

C_CS+

C_VREFC_AH

C
_C

H

C_XIN

C
_C

U
R

R
E

N
T

C
_D

B
G

C
_C

IN
P

C_TXD

C
_B

L

C_BH

C
_C

L

C_3_3V

C
_V

+

C_VB
C_VA

C_VREF

C_GND

C_GND C_GND

C_3_3V
C_VC

C_DBG

C_NRESET

C_GND

C_GND

C_GND

C_GND

C_GND

C_GND

C
_
C
M
D

C
_
E
N
A
B
L
E

C_SCL

C_GND

C_3_3V
C_SCL
C_SDA
C_GND

C_GNDC_GND

C_GND

C_GND

C_GND

C_3_3V

C_GND

C_3_3V
C_GND

C_C6

0.01uF

C_R3
10.0K

C_C8

UNUSED

C_C14

UNUSED

C_R2
11.0K

1
2

C_P4

con 2

C_R1
10.0K

C_C10

0.01uF

1
2

C_P8

con 2

1
2

C_P7

con 2

C_R11
10.0K

1
2

C_P3

con 2

C_C7

2200pF

C_C2

100pF

C_C11

0.1uF

C_C19

2200pF

PB2/ANA2/T0IN0 1PB1/ANA1/T0IN1 2PB0/ANA0/T0IN0 3AVDD 4AGND 5VREF 6PA0/OPINN 7PA1/OPINP/CINN 8

PA
2/

C
IN

P
9

PB
7/

A
N

A
7

28

R
E

SE
T

/F
A

U
L

T
0

11
D

B
G

12
PC

0/
T

0O
U

T
13

PW
M

2L
14

PW
M

2H
15

PW
M

1L
16

PWM1H17

PWM0L18

PWM0H19

GND20

XOUT21

XIN22

VDD23

PA3/TXDE/SCK/SCL24

PA
4/

R
X

D
/M

IS
O

25

PA
5/

T
X

D
/M

O
SI

26

PA
6/

C
T

S/
SS

/S
D

A
27

PB
6/

A
N

A
6

29

PB
5/

A
N

A
5

30

PB
4/

A
N

A
4/

C
IN

N
31

PB
3/

A
N

A
3/

O
PO

U
T

32
PA

7/
FA

U
L

T
1/

T
0O

U
T

/C
O

U
T

10

C_U1
Z8FMC16_32LQFP

1
2

C_P6

con 2

11

2
2

3 3

C_Y1

20MHz

1
2
3
4

C_P17

con 4

C_C5

0.1uF
C_C9

UNUSED

C_C18

UNUSEDC_C17

UNUSED

C_R9

100K

C_R12
10.0K

C_C1

0.1uF

C_C12

0.1uF

C_C13

10uF 6.3V

1
2

C_P5

con 2

C_R4
10.0K

1
2

C_P1

con 2

0805CCR20.0MXC7T

1
2

C_P2

CON2

1
2
3

CP10

CON3

C_RXD

C_ENABLE
C_GND

TP1
CURRENT

TP2

TEMP



U Appendix C—Schematics

Vector Control Development Kit
User Manual

37

6

A

B

C

D

6

Number Revision

2-Jan-2007 Sheet    of 
:\Documents and Settings\rallison.ICSNT\My Documents\_Projects\Modular Controller\HV Gate Drive ModuleDrawn By:

HV GATE DRIVE MODULE

96C1017-001 A
M021402-0407  

Figure 20. HV Gate Drive Module Schematic
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Figure 21. HV Power Module Schematic
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Figure 22. Washing Machine Interface Module Schematic

1 2 3 4 5

54321

D

C

B

A

Title

NSize

B

Date: 26-
File: C:\P

W_ISO_ANODE

W_GND

W_ANODE

W_3_3V

W_3_3V

W_ISO_GND
W_ISO_DATA
W_ISO_5V

W_GND

W_C2

0.1uF

W_C1

0.1uF

W_R1
220

1

2

3

4 5

6

7

8

W_U2

6N137

W_R3
390

1

2

3

4 5

6

7

8

W_U1

6N137

1
2
3

W_P5

con 3

W_R4
4.99K

W_R2
4.99K

200mil spacing from rest of circuitry
W_T1
W_T2

W_BASE

W_3_3V

W_GND

2

3
1

W_D2
BAS16

W_C5

0.1uF

W_R6 10.0K

2

3
1

W_D1
BAS16

1
2

W_P4

con 2

W_R5
10.0K

W_C4

0.1uF

TACH/TURN SENSOR

OPTOISOLATED UART

1
2

W_P1

CON2

1
2
3

W_P3

CON3

W_C3

0.1uF

W_GND
W_GND

W_TXD
W_RXD



U Appendix C—Schematics

Vector Control Development Kit
User Manual

40

4

A

B

C

D

4

Revision

Sheet    of 
ROJECTS\APPLICATIONS\Rex\HiVoltRefDesDrawn By:

E

1 A
M021402-0407  

Figure 23. DAC Module Schematic
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Customer Support
For answers to technical questions about the product, documentation,  
or any other issues with ZiLOG’s offerings, please visit ZiLOG’s Knowl-
edge Base at http://www.zilog.com/kb.

For any comments, detail technical questions, or reporting problems, 
please visit ZiLOG’s Technical Support at http://support.zilog.com.
UM021402-0407 Customer Support

http://support.zilog.com
http://www.zilog.com/kb
http://www.zilog.com/kb
http://www.zilog.com/kb
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DO NOT USE IN LIFE SUPPORT

LIFE SUPPORT POLICY
ZiLOG'S PRODUCTS ARE NOT AUTHORIZED FOR USE AS CRITICAL 
COMPONENTS IN LIFE SUPPORT DEVICES OR SYSTEMS WITHOUT THE 
EXPRESS PRIOR WRITTEN APPROVAL OF THE PRESIDENT AND GENERAL 
COUNSEL OF ZiLOG CORPORATION. 

As used herein
Life support devices or systems are devices which (a) are intended for surgical implant 
into the body, or (b) support or sustain life and whose failure to perform when properly 
used in accordance with instructions for use provided in the labeling can be reasonably 
expected to result in a significant injury to the user. A critical component is any 
component in a life support device or system whose failure to perform can be reasonably 
expected to cause the failure of the life support device or system or to affect its safety or 
effectiveness.

Document Disclaimer
©2007 by ZiLOG, Inc. All rights reserved. Information in this publication concerning the 
devices, applications, or technology described is intended to suggest possible uses and 
may be superseded. ZiLOG, INC. DOES NOT ASSUME LIABILITY FOR OR 
PROVIDE A REPRESENTATION OF ACCURACY OF THE INFORMATION, 
DEVICES, OR TECHNOLOGY DESCRIBED IN THIS DOCUMENT. ZiLOG ALSO 
D O E S  N O T  A S S U M E LI A B I L I T Y  F O R  I N T E L L EC T U A L  PR O P E RT Y  
INFRINGEMENT RELATED IN ANY MANNER TO USE OF INFORMATION, 
DEVICES, OR TECHNOLOGY DESCRIBED HEREIN OR OTHERWISE. The 
information contained within this document has been verified according to the general 
principles of electrical and mechanical engineering. 

Z8, Z8 Encore!, eZ80, and eZ80Acclaim!, and Z8 Encore! XP are registered trademarks of ZiLOG, Inc. All 
other product or service names are the property of their respective owners.

Warning:
UM021402-0407 Customer Support
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